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Abstract

These Application Notes describe the steps to configure Session Initiation Protocol (SIP)
Trunking for an enterprise solution using Avaya IP Office 10.0 to interoperate with the Pure IP
SIP Trunking Service.

The Pure IP SIP Trunking Service provides PSTN access via a SIP trunk between the
enterprise and the Pure IP network as an alternative to legacy analog or digital trunks. This
approach generally results in lower cost for the enterprise. Pure IP is a member of the Avaya
DevConnect Service Provider program.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps to configure Session Initiation Protocol (SIP)
Trunking for an enterprise solution using Avaya IP Office 10.0 to interoperate with the Pure IP
SIP Trunking Service.

The Pure IP SIP Trunking Service will enable delivery of origination and termination of local,
long-distance and toll-free traffic across a single broadband connection. A SIP signaling
interface will be enabled to the Customer Premises Equipment (CPE).

2. General Test Approach and Test Results

The general test approach was to connect a simulated enterprise site via the public Internet and
exercise the features and functionality listed in Section 2.1. The simulated enterprise site was
comprised of Avaya IP Office and various Avaya endpoints listed in Section 4.

The Pure IP SIP Trunking Service passed compliance testing with any observations or
limitations described in Section 2.2.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered
during the interoperability compliance test:

Establishment of the SIP trunk

SIP OPTIONS queries and responses

Incoming PSTN calls (via the SIP trunk) to SIP and H.323 telephones at the enterprise
Outgoing PSTN calls (via the SIP trunk) from SIP and H.323 telephones at the enterprise
Inbound and outbound PSTN calls to/from Avaya Communicator for Windows and
Avaya Communicator for Web

Various call types including: local, long distance, outbound toll-free, international (00 +
country code + number) and local directory assistance

Codecs G.711A and G.729A

Caller ID presentation and Caller 1D restriction

DTMF transmission using RFC 2833

Response to incomplete call attempts and trunk errors

Voicemail navigation using DTMF input for inbound and outbound calls

Voicemail message waiting indicator (MWI)

User features such as hold and resume, internal call forwarding, transfer, and conference
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Off-net call forwarding and twinning (mobility)
T.38 and G.711 fax
Long duration calls and simultaneous active calls

Emergency calls and inbound toll-free calls are supported but were not tested as part of the
compliance test.

2.2. Test Results

Interoperability testing of the Pure IP SIP Trunking Service was completed with successful
results for all test cases with the exception of the observations/limitations described below.

Avaya IP Office terminating an inbound call results in error indication (in test
environment): On inbound calls from the PSTN to Avaya IP Office, if Avaya IP Office
hangs up first, the PSTN caller hears an error indication. Testing was performed using
international trunks between the UK and the US. This observation was believed to be
related to the test environment and is not expected to occur in a customer environment.
Performing the same test using local trunks in the UK did not have the same issue.
Privacy calls: Outbound privacy calls from Avaya IP Office were successful but
signaling shows an incorrect PAI header in the outbound INVITE. Avaya IP Office
sends “Unknown” as the host portion of the SIP URI in the PAI header instead of the
DDl assigned by the service provider to the caller. This is an Avaya issue and is being
investigated.

REFER messaging on redirected calls: When a PSTN call (inbound or outbound) is
redirected to another PSTN endpoint using REFER, the call is successfully transferred;
however, the call gets torn down before Pure IP sends the NOTIFY message to indicate
the transferred call has been answered. This may be one factor contributing to Avaya SIP
endpoints sometimes indicating that the transfer failed even when it was successful.
Avaya SIP endpoints may indicate that a transfer failed even when it is successful:
Occasionally on performing a transfer operation, Avaya IP Office SIP endpoints (Avaya
1100 Series Deskphone and Avaya Communicator for Windows) may indicate on the
local call display that the transfer failed even though it was successful. The frequency of
this behavior can be reduced by enabling “Emulate Notify for REFER” on the [PO SIP
Line.

2.3. Support

For technical support on the Pure IP SIP Trunking Service, please contact Pure IP via the
following:

Web: http://www.pure-ip.com
Phone: +44 203 242 0960

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-

8292) provides access to overall sales and service support menus.
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3. Reference Configuration

Figure 1 illustrates the sample configuration used for the DevConnect compliance testing. The
sample configuration shows an enterprise site connected to the Pure IP SIP Trunking Service.

The enterprise site contains an Avaya IP Office 500 V2 with various endpoints and a Windows
PC running both Avaya IP Office Manager to configure Avaya IP Office and Avaya Voicemail
Pro for voicemail. In addition, the Avaya IP Office Application Server is present to support use
of Avaya Communicator for Web (WebRTC client). For the compliance test, Avaya IP Office is
deployed in a 2-port configuration. The Avaya IP Office LANL port is connected to the private
enterprise LAN and the WAN (LAN2) port is connected to the public network.
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Figure 1: Avaya Interoperability Test Lab Configuration
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For security purposes, any public IP addresses or PSTN routable phone numbers used in the
compliance test are not shown in these Application Notes. Instead, public IP addresses have
been replaced with private addresses and all phone numbers have several digits masked.

For the purposes of the compliance test, users dialed a prefix digit 9 plus N digits to send an
outbound call to the number N across the SIP trunk to the service provider. The short code of 9
was stripped off by Avaya IP Office and the remaining N digits were sent to the service provider
network. Avaya IP Office sent the N digits in the Request URI and the To header of an outbound
SIP INVITE message.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the enterprise network such as a data firewall. A
complete discussion of the configuration of these devices is beyond the scope of these
Application Notes. However, it should be noted that SIP and RTP traffic between the service
provider and Avaya IP Office must be allowed to pass through these devices.

The administration of the Avaya Voicemail Pro messaging service and endpoints on Avaya IP
Office are standard. Since these configuration tasks are not directly related to the inter-operation
with the Pure IP SIP Trunking Service, they are not included in these Application Notes.

CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 50f 39
SPOC 2/8/2017 ©2017 Avaya Inc. All Rights Reserved. PurelP-IPO10



4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

Avaya Telephony Components

Equipment

Software

Avaya IP Office 500 v2

10.0 SP1 (10.0.0.1.0 Build 53)

Avaya IP Office Manager

10.0 SP1 (10.0.0.1.0 Build 53)

Avaya IP Office VoiceMail Pro

10.0 (10.0.0.0.0 Build 469)

Avaya IP Office Application Server
e 0ne-X® Portal
e WebRTC Gateway

10.0 SP1 (10.0.0.1.0 Build 53)
10.0 SP1 (10.0.0.1.0 Build 16)
10.0 SP1 (10.0.0.1.0 Build 3)

Avaya 1140E IP Deskphone (SIP)

4.4 SP2 (4.04.18)

Avaya 1616 IP Deskphone (H.323) running
Avaya one-X® Deskphone Value Edition

1.3.5 (1.3.50B)

Avaya 9641G IP Deskphone (H.323) running
Avaya one-X® Deskphone Edition

6.6.2 (6.6229)

Avaya Communicator for Windows

2.1.3 (2.1.3.237)

Avaya Communicator for Web 1.0.16.1718
Pure IP Components
Equipment Software
PortaOne PortaSwitch MR40-6-1
Sonus Session Border Controller V04.02.03R000

Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2 and also when deployed with IP Office Server Edition in all configurations.

Avaya IP Office Server Edition requires an Expansion IP Office 500 V2 to support analog/digital

endpoints or analog/digital trunks.
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the
Avaya IP Office Manager PC, select Start - All Programs - IP Office - Manager to launch
the application. A screen that includes the following may be displayed:

WELCOME to IP Office Administration

What would you like to do ?

Create an Offline Configuration

Oipen Configuration from System

Fead a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the
configuration may be alternatively opened by navigating to File > Open Configuration at the
top of the Avaya IP Office Manager window. Select the proper Avaya IP Office system from the
pop-up window and log in with the appropriate credentials.

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane
on the left side, omit the Group pane in the center, and show the Details pane on the right side.
Since the Group Pane has been omitted, its content is shown as submenus in the Navigation
pane. The Navigation and Details panes will be referenced throughout the Avaya IP Office
configuration. All licensing and feature configuration that is not directly related to the interface
with the service provider (such as twinning and Avaya Communicator support) is assumed to
already be in place.

In the sample configuration, Atlantic City was used as the system name. All navigation
described in the following sections (e.g., License = SIP Trunk Channels) appears as submenus
underneath the system name Atlantic City in the Navigation Pane.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require Avaya IP Office to
be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in
the Navigation pane. Confirm a valid license with sufficient Instances (trunk channels) appears

in the Details pane.

IP Offices |

v | < | >
- R BOOTP (3) License  Remote Server
[#-4# Operator (3)
-5 Atlantic City License Mode License Normal
g}“{ E?:Ze(r;sgm Licensed Version 10.0
-2 Control Unit (3) PLDS Host ID
[ Extension (23) . ’
D___a User (27) PLDS File Status  Valid
-5 Group (1)
Dg EZrD\rrch?[?)e (63) Feature Key Instances Status 2 Add...
D...@ RAS (1) Receptionist /A 4 Valid
E]---@ Inceming Call Route Additional Voicemail Pro Ports MN/A 152 Valid Remove
""" €2 WAN Port (0) VMPro Recordings Administrators N/A 1 Valid
::::? ?ii:;t;gél[’i o Essential Edition Additional Voice..  N/A 4 Valid
EJ@ Firewall Profile (1) VMPro TTS (Generic) MN/A 40 Valfd
w=-Jill 1P Route (4) Teleworker MN/A 384 Valid
----- & Account Code (0) Mobile Worker MN/A 384 Valid
----- L Y License (104)] Office Worker N/A 384 Valid
""" e Tunne.l 0 Avaya Softphone Licence N/A 100 Valid
gn‘(' i;‘;’ 3'39)”5 @ VMPro TTS (Scansoft) N/A 0 Valid
_____ i Location (0) VMPro TTS Professional MN/A 40 Valid
..... 2% Authorization Code ( IPSec Tunnelling M/A 1 Valid
Power User N/A 384 Valid
Avaya IP endpoints N/A 384 Valid
IP300 Voice Metworking Channels  N/A 32 Valid
SIP Trunk Channels N/A 128 Valid
IP500 Universal PRI (Additional cha... N/A 100 Valid
CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 8 of 39

SPOC 2/8/2017

©2017 Avaya Inc. All Rights Reserved.

PurelP-IPO10




To view the physical hardware comprising Avaya IP Office, expand the components under the
Control Unit in the Navigation pane. In the sample configuration, the second component listed
is a Combination Card. This module has 6 digital stations ports, two analog extension ports, 4
analog trunk ports and 10 VCM channels. The VCM is a Voice Compression Module supporting
VoIP codecs. An Avaya IP Office hardware configuration with a VCM component is necessary
to support SIP trunking.

To view the details of the component, select the component in the Navigation pane. The
following screen shows the details of the IP 500 V2.

IP Offices = IP 500 v2 [ v | < | >
=& BOOTP (3) Unit
[-4# Operator (3)
(-5 Atlantic City Device Mumber |'I |
...;.,,‘_, System (1) )
-7 Line (25) Unit Type [IP 00 v2 |
[l =+ Centrol Unit (3] . -
s (AR Version 10.0.0.1.0 build 53 |
o2 2 COMBOB210/ATIMA Serial Nurmb | |
= 3 DIGSTAS/ATM4 enal Humber
-4 Extension (25) .
Unit IP Add 10.32.128.25
w-§ User @7) n e | |
-5 Group (1) Interconnect Mumber |'D |
[+-@% Short Code (63)
4B Service (0) Medule Number |C0ntrol Unit |
[y RAS (1)
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5.2. System

Configure the necessary system settings.

5.2.1. System — LAN2 Tab

In the sample configuration, the Avaya IP Office WAN port was used to connect to the public
network. The LAN2 settings correspond to the WAN port on the Avaya IP Office 500 V2. To
access the LAN2 settings, first navigate to System = <Name>, where <Name> is the system
name assigned to the Avaya IP Office. In the case of the compliance test, the system name is
Atlantic City. Next, navigate to the LAN2 - LAN Settings tab in the Details Pane. Set the IP
Address field to the IP address assigned to the Avaya IP Office WAN port on the public
network. Set the IP Mask field to the mask used on the public network. All other parameters
should be set according to customer requirements.

IP Offices |

B

= Atlantic City

+- K& BOOTP (3)
+-4 Operator (3)
=I-*37 Atlantic City
f-"’-'- System (1)
+-17 Line (29)
+ = Control Unit (3)
ik
T

-4y Extension (23)
0§ User(27)
438 Group (1)
- 8% Short Code (65)
4B Service (0)
+ﬂ%< RAS (1)
+-@) Incoming Call Route (i
B WAN Port (0)
- Directory (0)

@ Firewall Profile (1)
+-Jill IP Route (4)

SMDR  VCM
Systern  LANT
LAN Settings  yolP

VolP
LANZ

VolP Security Contact Center
DS

Network Topology

IP Address 192 168 96 232
IP Mask 255 255 255 224
Primary Trans. [P Address 0 0 0 0
Firewall Profile <Mone>»
RIP Mode MNone

[] Enable NAT

-

Number Of DHCP IP Addresses (200
DHCP Mode

Voicemail Telephony Directory Services System Events  SMTP

Account Code (0) () Server (O Client (O Dialln (@) Disabled Advanced

Q; License (104)
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On the VoIP tab in the Details Pane configure the following parameters:

e Check the SIP Trunks Enable box to enable the configuration of SIP trunks.

e The RTP Port Number Range can be customized to a specific range of ports that Avaya
IP Office will use for RTP media. This port range will be used to select a destination port
for incoming RTP and a source port for outgoing RTP for calls using LANZ2.

"

Atlantic City

LAN Settings  VolP

Contact Center
System LANT LANZ  DNS

H.323 Gatekeeper Enable
[ Auto-create Extension

H.323 Signaling over TLS

SIP Trunks Enable

[] SIP Registrar Enable

Auto-create BExtension/User

RTP
Port Mumber Range

Minimum

Port Mumber Range (NAT)

Minimum

Voicernail Telephony Directory Services  Systemn Events  SMTP

Network Topelogy

SMDR WCM VolP VolP Security

Auto-create User ] H.323 Remote Extension Enable

Disabled ~

uDP 5060 =
TCP 5060 =
TLS 5061 =
10 B
49152 o Maximum 33246 =
a0152 = Maximum 53246 =

4

1720 =

4

SIP Remote Extension Enable

|
g
L3

]
]
=)
=1
4k
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Scroll down the page.

In the Keepalives section, set the Scope to RTP-RTCP. Set the periodic timeout to 30
and the Initial keepalives parameter to Enabled. These settings will cause Avaya IP
Office to send RTP and RTCP keepalive packets starting at the time of initial connection
and every 30 seconds thereafter if no other RTP/RTCP traffic is present. This facilitates
the flow of media in cases where each end of the connection is waiting to see media from
the other, as well as helping to keep firewall ports open for the duration of the call.

In the DiffServ Settings section, Avaya IP Office can also be configured to mark the
Differentiated Services Code Point (DSCP) in the IP header with specific values to
support Quality of Services policies for both signaling and media. The DSCP field is the
value used for media and the SIG DSCP is the value used for signaling. The specific
values used for the compliance test were the Avaya IP Office default values and are
shown in the screenshot below. Quality of Service (QoS) is not specifically tested as part
of the compliance test.

All other parameters should be set according to customer requirements.

x

Atlantic City i v

1100 Veice VLAM Site Specific Option Mumber (SSOM) 232 =

Contact Center

Systern LAM1 LANZ DS Voicemail Telephony Directory Services Systermn Events  SMTP SMDR VCM  VoIP VolIP Security
LAM Settings  VelP  Metwork Topology

Enable RTCP Monitoring on Port 5005

RTCP collector [P address for phones 0 0 0 0

Keepalives

Scope RTP-RTCP ~ | Periodic timeout
Initial keepalives Enabled -

DiffServ Settings

B 3 DSCP{Hex) BE 3 Video DSCP (Hex) |FC % DSCP Mask (Hex) 88 + SIGDSCP (Hex)

46 |3 Dscp 46 2| Video DSCP 63 || DSCPMask 34 12| sIGDscP

DHCP Settings

Primary Site Specific Option Number (SSOM) 176 o

Secondary Site Specific Option Nurnber (SS0M) 242 =

VLAN Mot Present w

1100 Voice VLAN 1Ds
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. Since no firewall or network address translation (NAT) device was used
between the Avaya IP Office and the service provider, the parameter was set to Open
Internet. With the Open Internet setting, the STUN Server Address is not used.

e Set Binding Refresh Time (sec) to 300. This value is used to determine the frequency at
which Avaya IP Office will send SIP OPTIONS messages to the service provider.

e Set the Public IP Address to the IP address assigned to the Avaya IP Office WAN port
in the LAN2->LAN Settings form earlier in this section.

e Inthe Public Port section, next to the transport protocol UDP, select the UDP port on
which Avaya IP Office will listen.

e All other parameters should be set according to customer requirements.

1

= Atlantic City 5 v | <>

Contact Center
Systen LANT LANZ  DNS Yoicemail Telephony Directory Services System Events SMTP  SMDR  VCM  VolP YolP Security

LAN Settings Vol Metwork Topology

Network Topelogy Discovery

STUN Server Address STUN Port 3478 =
Firewall/MAT Type Open Internet ~
Binding Refresh Time (sec) 300 =
Public IP Address 192 168 9 232 Run 5TUN Cancel
Public Port

uop 3060 o

TCP 0 >

LS 0 o

] Run STUN on startup
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5.2.2. System - Telephony Tab

To access the System Telephony settings, navigate to the Telephony = Telephony tab in the
Details Pane. Under Companding Law, set Switch to A-Law and Line to A-Law L.ine.
Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and call
transfer to the PSTN. If for security reasons incoming calls should not be allowed to transfer
back to the PSTN then leave this setting checked.

i= Atlantic City & <>

Contact Center
System LAN1  LANZ  DNS Vioicemail Telepheny Directory Services  System Events SMTP SMDR  WCM  VolP VolP Security
Telephony  Park & Page Tones & Music Ring Tones  SM Call Leg TUI

Analogue Extensions Companding Law ”
Switch Line
Default Qutside Call Sequence Normal ~
Default Inside Call Sequence Ring Type 1 w O U-Law U-Law Line
Default Ring Back Sequence Ring Type 2 ~
A-L A-Law Li
Restrict Analegue Extension Ringer Voltage [ @ w ® awHne
Dial Delay Time (sec) 4 = [] D35 Status
. ] Aute Held
Dial Delay Count 0 - e te
i = Dial By Mame
Default No Answer Time (zec) 25 = -
= Show Account Code
Hold Timeout (sec) 0 =
= 1 Inhibit Off-5Switch Forward/Transfer
Park Timeout (sec) 300 =
— [] Restrict Network Interconnect
Ring Delay (sec) ] -
- Include lecation specific information
Call Priority Promation Time (sec) |Disabled =
[] Drop External Only Impromptu Conference
Default Currency usD ~
[ Visually Differentiate External Call
Default Name Priority Favor Trunk ~
[] Unsupervised Analog Trunk Disconnect Handling
Media Connection Preservation Disabled ~
High Quality Conferencing
Phone Failback Manual A .
Digital/Analogue Aute Create User
Login Code Complexity O
Directory Overrides Barrin
[ Enforcement v g
n = [] Advertise Callee State To Internal Callers
Complexity v
< >
Help
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5.3. IP Route

A default route is needed so IP Office can reach other network subnets other than the one where
it resides. Navigate to IP Route - 0.0.0.0 in the left Navigation Pane if a default route already
exists. Otherwise, to create the default route, right-click on IP Route and select New.

Create/verify a default route with the following parameters:

e Set IP Address and IP Mask to 0.0.0.0.

e Set Gateway IP Address to the IP address of the default router on the public network
where Avaya IP Office is connected.

e Set Destination to LAN2 from the drop-down list.

Click the OK button at the bottom of the page (nhot shown).

+e Inceming Call Route (71
-0 WAN Port (0)

o= Directory (0)

-1 Time Profile (0)

-8} Firewall Profile (1)

IP Offices = 0.0.0.0 ef - X v <>
- R BOOTP (3) IP Route
+-{% Operator (3)
S Atlantic City P Address 0 0 0 0
37 System (1)
| s Atlantic City 1P Mask ’ ° ° ’
#- T4 Line (25) Gateway IP Address 192 . 168 . %6 . 234
+-<2 Control Unit (3)
+® Extension (235) Destination LANZ ~
@ User (27) =
+a Group (1) Metric o -
8% Short Code (65)
..... @ Service (0] D Proxy ARP
oy RAS (1)
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5.4. SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the Pure IP
SIP Trunking Service. The recommended method for configuring a SIP Line is to use the
template associated with these Application Notes. The template is an .xml file that can be used
by IP Office Manager to create a SIP Line. Follow the steps in Section 5.4.1 to create the SIP
Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses

e SIP Credentials (if applicable)

e SIP URI entries

e Setting of the Use Network Topology Info field on the Transport tab

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.4.2 — 5.4.8.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls

e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required
e SIP Advanced

e Engineering

To create a SIP Line manually, right-click Line in the Navigation Pane and select New = SIP
Line; then, follow the steps outlined in Sections 5.4.2 — 5.4.8.
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5.4.1. SIP Line From Template

1. Copy the template file to the computer where IP Office Manager is installed. Place it in
an empty directory. This is important because Step 2 will import all templates located in
this directory not just the template file associated with these Application Notes.

2. Import the template into IP Office Manager. From IP Office Manager, select Tools =
Import Templates in Manager. This action will copy all the template files located in
the selected directory into the IP Office template directory and make the templates
available in the IP Office Manager pull-down menus in Step 3.

U™ Avaya IP Office Manager Atlantic City
File Edit VWiew | Tools | Help
8= a E Extension Renumber...
Atlantic City Line Renurnber...
Connect Ta... 1
IP O
Export [ 4
‘!‘ BOOTP (3) S5CM Service User Management Tl
[-i# Operator (3]
EI---’-;- Atlantic City Busy on Held Validation
-5 Systermn (1)
T3 Line (25) M5M Configuration
B2 Control Unit Print Button Labels
L4 Extension (2 5
a User (27) Import Templates in Manager
-8 Group (1) License Migration
=--B% Short Code (B3] |
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In the pop-up window that appears, select the directory where the template file was
copied in Step 1, then click OK.

Browse For Folder X

Select a folder to import templates from -

‘ Desktop
@ Onelrive

a Tester
A This PC
s Libraries
¥ Metwork
»§ Homegroup
[E5] Control Panel

& Recycle Bin

Cancel

After the import is complete, a final import status pop-up window will appear stating
success or failure (not shown). Click OK (not shown) to continue.

Note - Within Avaya IP Office Manager menus, the template directory may be accessed
by navigating to C:\Program Files\Avaya\lP Office\Manager\Templates. However,
the template directory is physically located in the User Access Control Virtual Store area
of Windows. To view the directory from outside Avaya IP Office Manager (e.g.,
Windows Explorer), replace the C: portion of the template path above with
%UserProfile%\AppData\Local\VirtualStore.
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3. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane,
and select New From Template = Open File.

IP Offices = sl
@R BOOTP (3) SIP Line Transport SIP URI VolP  T38 Fax SIP Ci
4% Operator (3)
- AtlantpeCite T 17
"""'-i.-' < "_1 Mew .
Tfﬁ 1 10.32.12
H-== Cd § Cut Ctrl+X
- Bxt 53 Copy Crl+C © I:
a Us
u Gr Paste Ctrl+V SIP
g Shi 2 Delete Cerl+Del Cloud
Bi-o; RA +"  \Validate
@ Ing Connect To... Ctrl+T
Eﬂ W*’| Mew from Template » " Open from file
e Export as Templat —
LT port as Template T
_ }i Tlr P e e o | FISfinnal Breti: r:l

4. The subsequent pop-up window opens to C:\Program Files\Avaya\lP
Office\Manager\manager_files\template. Navigate to C:\Program Files\Avaya\lP
Office\Manager\Templates. The up arrow icon can be used to move up through the
directory tree.

U™ Open x
= v « manager_files » template w [ Search template 2
Organize « Mew folder == =« [ o
& OneDrive ] Mame Date modified Type
I This PC Mo itermns match your search.
[ Desktop
@ Documents
‘ Downloads
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5. Once reaching the correct directory, select Template Files (.xml) in the lower right

corner to ensure that .xml template files are displayed. From the list of template files,
select the one to be used and click Open.

f Open 4
= v P <« Manager » Templates v Search Templates 2
Organize « Mew folder =~ W @
IPO (e Name " Date modified Type
IO = PurelP-IPO10xml 12/20/2016 250 PM XML Dacum
IPO5creens

Testplan Traces
f@ Onelrive

& This PC
[ Desktop
|= Docurnents
“ Downloads
J‘J Music
= | Pictures
B Videos

‘o Local Disk (C:) wlla

File name: | PurelP-1PO10xmI v| |Temp|ate Files (*aml) w

A final status pop-up window will appear stating whether the trunk creation was a
success or failure (not shown). Click OK (not shown) to continue.

6. Once the SIP Line is created, verify the configuration of the SIP Line with the
configuration shown in Sections 5.4.2 — 5.4.8.
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5.4.2. SIP Line — SIP Line Tab
On the SIP Line tab in the Details Pane, configure or verify the parameters as shown below.

e Set the ITSP Domain Name to the IP address of the Pure IP SIP proxy provided by Pure
IP.

e Check the In Service box. This makes the trunk available to incoming and outgoing
calls.

e Check the Check OOS box. Avaya IP Office will use the SIP OPTIONS method to
periodically check the SIP Line. The time between SIP OPTIONS sent by Avaya IP
Office will use the Binding Refresh Time for LANZ2, as shown in Section 5.2.1.

e Set the Refresh Method to Auto and the Timer (seconds) to 300. This will cause
Avaya IP Office to send an UPDATE or INVITE message (depending on what the far-
end supports) every 150 seconds (1/2 the Timer value) to check the state of each active
session.

e Set the Country Code to the proper value for the location.

e Use of REFER should be configured as per the needs of the customer. Call flows with
and without REFER were tested as part of the compliance test. See Section 2.2 for more
details. To enable REFER, set the Incoming Supervised REFER field and Outgoing
Supervised REFER field to Always. To disable REFER, set these fields to Never.

e Default values may be used for all other parameters.

IP Offices ‘ = SIP Line - Line 19 ek - K v <]

- &) BOOTP (3) SIP Line Transpert SIP URI VoIP  T38 Fax SIP Credentials SIP Advanced Engineering
*:'--'.;' Operator (3)
% Atlantic City Line Nurmber 19 S In Service
427 System (1)
51 TSP Domain Name [192.168.21.188 | checkoos
H-<= Control Unit (3)
+¢ Extension (23) Local Domain Name | |
:;ﬂ g::;;a;]] URI Type SIP ~ Session Timers
+s z::{ig?&e 63) Location Cloud ~ Refresh Method Auto “
-aly RAS (1) Tirner (sec) 200
+@ Inceming Call Rout
- §F WAN Port (0)
;ﬂf.\ D.iractory FD] Prefix | |
+@ ;'g;:‘r;?‘:ﬁf?m National Prefix [o |
+E chzﬁft(éide o International Prefix |DD |
E License (105) Country Code |44 | Redirect and Transfer
+;Pf ELSIS::‘IQ(EL (8) Mame Priority System Default - Incoming Supervised REFER Always e
+é f:(sagji o Description | | Outgoing Supervised REFER Always ~
-8 Authorization Code Send 302 Moved Temporarily (]
Outgoing Blind REFER O
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5.4.3. SIP Line - Transport Tab
Select the Transport tab. Set or verify the parameters as shown below.

e Set the ITSP Proxy Address to the IP address of the Pure IP SIP proxy provided by Pure
IP.

e Set Layer 4 Protocol to UDP.

e Set Use Network Topology Info to the network port used by the SIP line to access the
far-end and configured in Section 5.2.1.

e Set the Send Port to 5060.

e Default values may be used for all other parameters.

0

= SIP Line - Line 19 ek - X v < s

SIP Line Transport S|P URI VolP  T38 Fax SIP Credentials SIP Advanced Engineering

ITSP Proxy Address [192.168.21.188 |

Metwork Configuration

Layer 4 Protocol Uupp w Send Port | 3060 =
Use Network Topology Info | LAM 2 w 3060 =
Explicit DMS Server(s) ] 0 0 0 0 0 0 ]

Calls Route via Registrar

Separate Registrar |
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5.4.4. SIP Line — SIP Credentials

The Pure IP SIP Trunking Service does not require SIP credentials for registration or
authentication so the SIP Credentials tab has no entry.

= SIP Line - Line 19 =R AR A AR
SIP Line Transport SIP URI VolP  T38 Fax SIP Credentials S|P Advanced Engineering
Index User Name Authentication Mame Contact Expiration (mins) Register Add...
Remove
Edit...
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5.4.5. SIP Line - SIP URI Tab

The set of SIP URI entries define which incoming calls will be accepted on the line and provide
configuration control of various SIP headers for outbound calls.

To create a SIP URI entry, select the SIP URI tab, then click the Add button and the New
Channel area will appear at the bottom of the pane. For the compliance test, a single SIP URI
entry was used for inbound and outbound calls. The entry was created with the parameters
shown below:

e Set Local URI, Contact and Display Name to Internal Data. For outbound calls, these
settings will populate the user portion of the From and Contact headers as well as the
display name with the contents of the User = SIP tab (Section 5.7). The User - SIP
tab is only present if a trunk in the system has a SIP URI using Internal Data. The
Local URI setting also impacts inbound calls. In this case, an inbound call is only
accepted if the user portion of the inbound Request-URI matches a value configured on
the system for a user (User = SIP), hunt group (Hunt Group = SIP) or voicemail
(System => Voicemail).

e Under Identity, set Identity to None. This disables the sending of the P-Asserted
Identity (PAI) and P-Preferred ID (PPI) header in each outbound INVITE. The PAI
header is only sent for privacy and is configured in Section 5.4.8.

e Under Forwarding and Twinning, set Send Caller ID to Diversion Header. With this
setting, Avaya IP Office will include the Diversion Header for calls that are forwarded or
directed via Mobile Twinning out the SIP Line. The Diversion Header will contain the
redirecting party which is a DDI number provided by the service provider.

e Set Diversion Header to None. This disables the sending of the Diversion header in
each outbound INVITE. The Diversion header is only sent for Forwarding and
Twinning as described above.

e For the Registration field, select 0: <None> from the pull-down menu.

e Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line in Section 5.8.1. Similarly, associate the line to an outgoing line
group using the Outgoing Group field. The outgoing line group number is used in
defining ARS entries for routing outbound traffic to this line in Section 5.5. For the
compliance test, a new incoming and outgoing group 19 was defined that only contained
this line (line 19).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

Click OK.
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7

SIP Line - Line 19* gk - X | v <>

SIP Line Transport 3IP URI yglp

T38 Fax SIP Credentials SIP Advanced Engineering

URl' Groups Local URI

Contact

Add..

Display Mame Identity Header Originator Number Send Caller 1D Diver
Remove

Edit...

Ferwarding And Twinning

Mew URI oK
Local URI |U5e Internal Data V|
Cancel
Contact |U5e Internal Data v|
Display Mame |U5e|ntema| Data V|
Identity
Identity |Nor1e V|
Header P Asserted ID V

Outgoing Group 15

Max Sessions 10

Originator

Mumber

send Caller 1D Diversion Header ~

Diversion Header |NDFIE w
Registration 0: <None> ~
Incoming Group 19 v

If using Internal Data, additional SIP URIs may be required to allow inbound calls to numbers
not associated with a user, such as a short code. These URIs are created in the same manner as
shown above with the exception that the incoming DDI number is entered directly in the Local
URI, Contact, and Display Name fields.
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5.4.6. SIP Line - VoIP Tab

Select the VoI P tab, to set the Voice over Internet Protocol parameters of the SIP line. Set or
verify the parameters as shown below.

For Codec Selection, select System Default from the pull-down menu to use the default
list of codecs. A list of the codecs in their current order of preference will be shown on
the right in the Selected column. To use a custom list of codecs, select Custom for
Codec Selection. Next, move unwanted codecs from the Selected column to the Unused
column. Lastly, move the codecs up or down the list in the Selected column to achieve
the desired order of preference. The example below shows the codecs used for the
compliance test.

Uncheck the VolP Silence Suppression box.

Check the Re-invite Supported box.

Set the Fax Transport Support to T38 Fallback. Using the T38 Fallback setting
allows fax calls to fallback to G.711 fax if the request to use T.38 fax is not accepted.
Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

Default values may be used for all other parameters.

=

SIP Line - Line 19 g - X v < |

SIP Line Transport SIP URI VolP 738 Fax SIP Credentials SIP Advanced Engineering

[ VolP Silence Suppression

[J Local Hold Music

Codec Selection Custom s Re-invite Supported
u d Selected
nuse Flecte [ Codec Lackdown
vos e alawe
(3.729(a) BK CS-ACELP [] Allow Direct Media Path

G711 ULAW 84K
G.723.1 6K3 MP-MLQ
G.722 64K [] PRACK/100rel Supported

Force direct media with phones

[ G.711 Fax ECAN

==

Fax Transport Support | T38 Fallback w
DTMF Support RFC2833 v
Media Security Disabled ~
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5.4.7. SIP Line —T38 Fax Tab
Select the T38 Fax tab. Leave the Use Default Values box checked at the bottom of the screen.

SIP Line - Line 19

T

X | v | < >

Use Default Values

SIP Line Transport 5P URI YolP

=

3

UDPTL

Trans TCF
14400

2600
000

T38 Fax SIP Credentials SIP Advanced Engineering

Scan Line Fix-up

TFOP Enhancement
Disable T30 ECM

Disable EFlags For First DIS

Disable T30 MR Compression

NSF Override

3

-
0

4

i -
0

4k

4F
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5.4.8. SIP Line — SIP Advanced
Select the SIP Advanced tab. Set the parameters as shown below.

e Set Call Routing Method to Request-URI. Avaya IP Office will route calls based on
the contents of Request URI in the incoming INVITE.

e Check the Use PAI for Privacy box. If Identity is set to None on the SIP Line > SIP
URI tab, then by default Avaya IP Office will send the P-Preferred-Identity (PPI) header
when placing a privacy call. Checking this option will cause Avaya IP Office to send the
P-Asserted-Identity (PAI) header instead. See Section 2.2 for limitations.

e Check the Emulate NOTIFY for REFER box. With REFER enabled, the Avaya 1100
Series Deskphones and Avaya Communicator for Windows expects to receive a NOTIFY
message to indicate that the referred (i.e., transferred) call was successful. If the
NOTIFY is not received from the far-end, then the call display will indicate that the
transfer failed even if the transfer was successful. If the Emulate NOTIFY for REFER
box is checked, then Avaya IP Office will send a NOTIFY message (on behalf of the far-
end) to the Avaya 1100 Series Deskphones and Avaya Communicator for Windows.

Click the OK button at the bottom of the page (nhot shown).

= SIP Line - Line 19

SIP Line Transport SIP URI VolP 738 Fax SIP Credentials 5IP Advanced Engineering

Addressing Media
Association Method By Source IP address w Allow Empty INVITE |
Send Empty re-INVITE |
Call Routing Method R <t URI ™
a7 Mouting ° S Allow To Tag Change |
Suppress DNS SRV Lookups O P-Early-Media Support MNone ~
Send SilenceSupp=0Off |
Identity
Use "phone-conted” O Media Connection Disabled "
Add user=phone O Preservation
Use + for International O Indicate HOLD O
Use PAIl for Privacy |
Use Domain for PAI O Call Control
Swap Fi d PAl/Diversi =
wap From and PA/Diversion ] Call Initiation Timeout (5) 4 z
Caller ID from From header |
Send From In Clear O Call Queuing Timeout (mins) 5 =
Cache Auth Credentials Service Busy Response 486 - Busy Here
User-Agent and Server Headers l:l on Mo User Responding Send | 408-Request Timeout

Send Location Info

MNever ~

Action on CAC Location Limit | Allow Voicemail

Suppress 0.850 Reason O
Header

Emulate NOTIFY for REFER |
Mo REFER if using Diversion O
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5.5. Alternate Route Selection (ARS)

Alternate Route Selection (ARS) is used to route outbound traffic to the SIP line. To define a
new ARS route, right-click ARS in the Navigation pane and select New. In the Details pane that
appears, enter a name for the route in the Route Name field and a collection of matching
patterns (similar to short codes) can be entered to route calls as shown below.

For the compliance test, two entries were created. The first entry matches on 0 and the second
entry matches on any other number N.

To create an entry, click the Add button and enter the following in the pop-up window (not
shown).

e Inthe Code field, enter the pattern to match the number passed to ARS from the short
code in Section 5.6. The value N; will match any number.

e Set Feature to Dial. This is the action that the entry will perform.

e For Code 0, set Telephone Number to 0”@ipaddr”, where ipaddr is the IP address of
the Pure IP SIP proxy and used to configure the trunk in Section 5.4.3. Adding the IP
address in this field was required to ensure that the correct Request-URI header appears
in the outbound INVITE when dialing 0. This was not required when matching on any
other dialed number as shown next.

e For Code N;, set Telephone Number to N. This field is used to construct the Request-
URI and To headers in the outgoing SIP INVITE message. The value N represents the
complete number passed to ARS.

e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on

the SIP Line in Section 5.4.5. This entry will use this line group when placing the
outbound call.

Click the OK button (not shown).

IP Offices |E Pure IP Route I IE I
=R 800TP () ARS
-4 Operator (3)
=155y Atlantic City ARS Route ID 63 [ Secondary Dial tene

ninpimiin 8 & ]
=~ Line (25) -
L ot | Poutetame e
#-4 Extension (25)
+"§ User (27) Dial Delay Time System Default (4) = [] Check User Call Barring
=-5af Group (1)
- #% Short Code (63) Descripti | ‘

@ Service (0) escription
sl RAS (1)
X @ Incoming Call Route
Ea WAN Port (0) In Service Qut of Service Route <MNone> ~
-~ Directory (0) l
£ Time Profile (0)
=@ Firewall Profile (1) Time Profile <None> et QUt 0f Hours Route <None> v
=-Jiill 1P Route (4)
- Account Cede (0) l

% License (103)
@ Tunnel (0] Code Telephone Number Feature Line Group ID Add...
- §5 User Rights (8)
+Km 0 0"@192.168.21.188" Dial 19

& Location (0) M N Dial 19 Remove
% Authorization Code (0

ﬁ ¢ Edit...
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5.6. Short Codes

A short code is a dial pattern that triggers a specific function. A short code is used by the caller
to route outbound traffic to ARS. To create a short code, right-click on Short Code in the
Navigation Pane and select New. On the Short Code tab in the Details Pane, configure the
parameters as shown below.

¢ Inthe Code field, enter the dial string which will trigger this short code, followed by a
semi-colon. In this case, 9N;. This short code will be invoked when the user dials 9
followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.

e Setthe Line Group ID to the ARS route to be used (Section 5.5).

Click the OK button (not shown).

IP Offices E 9N;: Dial AR
- R BOOTP (3) Short Code
-4 Operator (3)
;---L-j:- Atlantic City Code |9N,‘ |
+-4550 System (1)
+-F7 Line (25) Feature Dial d
<= Control Unit (3)
+-48 Extension (25) Telephone Mumnber |N |
:% gi;zg) Line Group 1D |63: Pure IP Route V|
RG] | e 5
B Service (0)
oy RAS (1) Force Account Code O
+® Incoming Call Route (7| £y oythorization Code []
B WAN Port (0)
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Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the
screen shown below, the short code *67N; is illustrated. This short code is similar to the 9N;
short code except that the Telephone Number field begins with the letter W, which means
“withhold the outgoing calling line identification”.

In the case of the SIP Line documented in these Application Notes, when a user dials *67 plus
the number, Avaya IP Office will include the calling number in the P-Asserted-Identity (PAI)
header and will include the Privacy: Id header.

= *67N:: Dial £ - X | v < :-|‘
Short Code

Code *BTM; |

Feature Dial w

Telephone Mumber |WN |

Line Group ID 163: Pure IP Route v]

Locale o

Force Account Code ]

Force Authorization Code [
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5.7. User

If the SIP Line is configured to use Internal Data in Section 5.4.5, then configure the SIP
parameters for each user that will be placing and receiving calls via the SIP line. To configure
these settings, first navigate to User - Name in the Navigation Pane where Name is the name of
the user to be modified. In the example below, the name of the user is Extn243. Select the SIP
tab in the Details Pane. The values entered for the SIP Name and Contact fields are used as the
user part of the SIP URI in the From and Contact headers for outgoing SIP trunk calls and allow
matching of the SIP URI for incoming calls without having to enter this number as an explicit
SIP URI for the SIP line (Section 5.4.5). The example below shows the settings for user
Extn243. The SIP Name and Contact are set to one of the DDI numbers assigned to the
enterprise from Pure IP. The SIP Display Name (Alias) parameter can optionally be configured
with a descriptive name. If all calls involving this user and a SIP Line should be considered
private, then the Anonymous box may be checked to withhold the user’s information from the
network.

Click the OK button (not shown).

-

= Extn243: 243 gk -8 X[ v u&%l

User Voicemail DMD Short Codes  Source Mumbers  Telephony  Forwarding  Dial In
Voice Recording  Button Programming  Menu Programming  Moebility  Group Membership

Announcements  3IP Perscnal Directory  Web Self-Administration

SIP Name |44113: 1235 |

SIP Display Mame (Alias) |Ertr1243 |

Contact |44113. 1235 |

(] Anonymous
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5.8. Incoming Call Route

An incoming call route maps an inbound DDI number on a specific line to an internal extension.
This procedure should be repeated for each DDI number provided by the service provider. To
create an incoming call route, right-click Incoming Call Routes in the Navigation Pane and
select New.

5.8.1. Incoming Call Route — Standard Tab
On the Standard tab of the Details Pane, enter the parameters as shown below.

e Set the Bearer Capacity to Any Voice.

e Setthe Line Group Id to the incoming line group of the SIP line defined in Section
5.4.5.

e Set the Incoming Number to the incoming number on which this route should match.

e Default values can be used for all other fields.

X

IP Offices ‘ = 1911301235 i X v =< =
---3 BOOTP (3) Standard  Voice Recording  Destinations
- Operator (3)
-5 Atlantic City
-5 System (1) Bearer Capability Any Voice ~
T4 Line (25)
- Control Unit (3) Line Group ID 19 v]
-4 Extension (25)
E-§ User (27) Incoming Mumber |'|13: 1235 |
G-1f Group (1)
-8 Short Code (65) Inceming Sub Address | |
----- @ service (0) .
5ol RAS (1) Inceming CLI | |
=28 - Incoming Call Route (7] I ”
----- BB WAN Port (0)
----- @ Directory (0) Pricrity 1-Low ~
-7 Time Profile (0)
G- Firewall Profile (1) Tag | |
=-Jill 1P Route (4)
..... #m Account Code (0) Hold Music Source Systern Source w
----- % License (103) i )
..... @& Tunnel (0) Ring Tone Override |N0ne v|
I -

5.8.2. Incoming Call Route — Destinations Tab

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. Click the OK button (not shown). In this example, the incoming number on
line 19 is routed to extension 243.

W

= 19 11301235 i X v < 2
Standard Voice Recording Destinations
TimeProfile Destination Fallback Extension
2 Default Value 243 BExtn243 w w
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Incoming Call Routes for other direct mappings of DDI numbers to Avaya IP Office users listed

in Figure 1 are omitted here, but can be configured in the same fashion.

5.9. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the

configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service

disruption. Click OK to proceed.

Save Configuration

IP Office Settings

Configuration Reboot Mode
® Merge

() Immediate

) When Free

() Timed

Reboot Time

12:01 =

Call Barring

OK

Atlantic City

Cancel

Help
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6. Pure IP SIP Trunking Service Configuration

Pure IP is responsible for the configuration of the Pure IP SIP Trunking Service. The customer
will need to provide the IP address used to reach the Avaya IP Office at the enterprise. In the
case of the compliance test, this is the public IP address of the Avaya IP Office. Pure IP will
provide the customer the necessary information to configure Avaya IP Office including:

e Pure IP SIP proxy IP address
e Transport protocol and port
e DDI numbers

In addition, to configure any possible firewall/security devices at the enterprise, Pure IP will
provide the IP address and port of any media sources that will need access to the enterprise.

7. Verification Steps

This section provides verification steps that may be performed in the field to verify that the
solution is configured properly.

7.1. Avaya IP Office

7.1.1. System Status

The System Status application is used to monitor and troubleshoot Avaya IP Office. Use the
System Status application to verify the state of the SIP trunk. System Status can be accessed
from Start = All Programs = IP Office = System Status.

The following screen shows an example Logon screen. Enter the Avaya IP Office IP address in
the Control Unit IP Address field, and enter an appropriate User Name and Password. Click
Logon.

+J Avaya IP Office System Status - O *

AVAyA IP Office System Status

Help Exit About

Online | offline

Logon

Control Unit IP Address: [plikFR kRl

Services Base TCP Port: ElkLE]

U ET ) Administrator

Password:

M Auto reconnect

. Secure connection
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

IP Office System Status

Status  Utilization Summary Alarms

SIP Trunk Summary
Line Service State: In Service
Peer Domain Name: 192,168.21.188
Resolved Address: 192.168.21.188
Line Number: 19
Mumber of Administered Channels: 10
Mumber of Channels in Use: 0
Administered Compression: G711 A, G729 A, G711 Mu, G7231, G722
Enable Faststart: Off
Silence Suppression: off
Media Stream: RTP
Layer 4 Protocal: UDP
SIP Trunk Channel Licenses: 128 . —
SIP Trunk Channel Licenses in Use: 0
SIP Device Features: UPDATE (Incoming and Qutgoing)
urrent Timein Remote Co... Conn... Caller ID Other Party Directi... Round Trans... Trans...
e State  Media ... or ... on Call Trip... Jitter Pa

1 Ide |14da... A

2 Ide |[14da...

3 Ide |17da...

4 Ide |17da...

5 Ide |17da...

[ Ide |[17da...

7 Ide |[17da... v
Trace Trace All Fause Fing Call Details Graceful Shutdown Force Qut of Service Print...
Save As...

2:18:40 PM Online &

Select the Alarms tab and verify that no alarms are active on the SIP line.

Status  Utlization Summary Alarms

Alarms for Line: 19 SIP 192.168.21.188

Last Date Of Error Occurrences Error Description
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7.1.2. Monitor

The Monitor application can also be used to monitor and troubleshoot Avaya IP Office. Monitor
can be accessed from Start > All Programs - IP Office - Monitor. The application allows
the monitored information to be customized. To customize, select Filters = Trace Options.

The following screen shows the SIP tab, allowing configuration of SIP monitoring.

All Settings *
T1 | PN WM | SON | Jade
&M | cal | DTE | ECont | FiameRelay | GOD | H.323 | Interface
ISOM | Kep/Lamp | Diectory | Media | FFF | B2 | Fouting | Services  SIP lSystem]
Events
¥ Sip |Standard - [# STUN [~ SIP Dect
Packets
[ SIF Reg /Opt Rx [ SIP Mizc Ax
[~ SIF RegOpt Tx [ SIP Mizc Tx
[~ SIF Call R= [~ Crn Motify Fi=
[~ SIPCall T [~ Crn Matify T=
[v SipFRx IP Filter [man. nnn.anm. sien)
WV SipTx |
Default AII| Clear Al | Tab I:Iear.-’-‘«||| Tab Set A||| o] cancel
Save File | Load File | Load Partial File‘ Select File ‘

8. Conclusion

These Application Notes describe the configuration necessary to connect Avaya IP Office 10.0 to
the Pure IP SIP Trunking Service. The Pure IP SIP Trunking Service is a SIP-based Voice over
IP solution for customers ranging from small businesses to large enterprises. It provides a
flexible, cost-saving alternative to traditional hardwired telephony trunks. The Pure IP SIP
Trunking Service passed compliance testing. Please refer to Section 2.2 for any
observations/exceptions.

37 of 39
PurelP-1PO10

CTM; Reviewed:
SPOC 2/8/2017

Solution & Interoperability Test Lab Application Notes
©2017 Avaya Inc. All Rights Reserved.



9. Additional References

This section references documentation relevant to these Application Notes. In general, Avaya
product documentation is available at http://support.avaya.com.

[1] Deploying Avaya IP Office Platform IP500 V2, Document Number 15-601042, Issue 319,
August 3, 2016.

[2] Administering Avaya IP Office Platform with Manager, Release 10, September 2016.

[3] Using System Status, Document Number 15-601758, Issue 11e, July 7, 2016.

[4] Administering Avaya IP Office Voicemail Pro, Document Number 15-601063, Issue 11e,
July 20, 2016.

[5] Using IP Office System Monitor, Document Number 15-601019, Issue 07b, June 9, 2016.

Additional Avaya IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/
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Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and
™ are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks
are the property of their respective owners. The information provided in these Application
Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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